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Phần 1: ỨNG DỤNG CÔNG NGHỆ THÔNG TIN TRONG DẠY HỌC
Bài 1. 
ĐẠI CƯƠNG VỀ ỨNG DỤNG THÔNG TIN 
                                            TRONG DẠY HỌC

1. Một số thuật ngữ
1.1. Công nghệ thông tin (Information Technology)
Khái niệm về công nghệ thông tin được thể hiện bởi rất nhiều định nghĩa, một vài trong số đó là:

- Xử lí thông tin bởi máy tính;
- Sự phát triển, cài đặt và thực thi một hệ thống máy tính và ứng dụng;
- Là một công nghệ dùng để xử lí thông tin; Cụ thể là việc sử dụng máy tính điện tử và phần mềm máy tính để chuyển đổi, lưu trữ, bảo vệ, xử lí, truyền và nhận thông tin từ bất cứ nơi đâu và bất cứ lúc nào.

1.2. Phần mềm dạy học
- Phần mềm: Thuật ngữ software được sử dụng đầu tiên bởi John W.Tukey năm 1957 được hiểu là chương trình, một đoạn chương trình điều khiển chức năng của phần cứng và định hướng hoạt động của nó. Có thể phân chia làm hai loại phần mềm đó là phần mềm hệ thống (System software) và phần mềm ứng dụng (Application software). 
Phần mềm hệ thống là một bộ chương trình điều khiển như hệ điều hành và hệ thống quản lí cơ sở dữ liệu. Phần mềm ứng dụng là bất cứ chương trình nào xử lí dữ liệu cho người sử dụng.

- Phần mềm máy tính: Phần mềm máy tính ám chỉ tới một hay nhiều chương trình máy tính quản lí trong bộ nhớ máy tính với những mục đích nhất định. Phần mềm thể hiện chức năng của chương trình nó thực thi bằng cách hoặc trực tiếp cung cấp các hướng dẫn cho phần cứng của máy tính hoặc phục vụ như là đầu vào của một đoạn khác của chương trình. 

- Phần mềm dạy học: Phần mềm dạy học là một phần mềm máy tính với mục đích dạy học. Nó bao gồm từ chương trình cho học mẫu giáo với hàng loạt các thành phần có chức năng giải trí tới các chương trình dạy đánh máy cũng như dạy tiếng nước ngoài cùng các mục đích dạy học khác.

2. Khả năng ứng dụng công nghệ thông tin trong dạy học

Trong những năm gần đây, công nghệ thông tin được coi là một trong những ngành khoa học phát triển với tốc độ nhanh nhất. Được như vậy là vì đây là một ngành khoa học phục vụ và mang lại hiệu quả rõ rệt cho hầu hết các ngành nghề khác nhau trong xã hội. Tuy vậy, tại Việt Nam, tiềm năng to lớn mà công nghệ thông tin có thể mang lại cho giáo dục chưa được khai thác thoả đáng. Xét cho quá trình giáo dục, với sự phong phú và đa dạng của các phần mềm dạy học, công nghệ thông tin hoàn toàn có thể trợ giúp cho quá trình học bởi những lí do dưới đây:

Thứ nhất, việc ứng dụng CNTT trong dạy học sẽ khiến máy tính trở thành một công cụ hỗ trợ đắc lực cho quá trình dạy học, cụ thể là:

1. Khả năng biểu diễn thông tin: Máy tính có thể cung cấp thông tin dưới dạng văn bản, đồ thị, hình ảnh, âm thanh,…sự tích hợp này của máy tính cho phép mở rộng khả năng biểu diễn thông tin, nâng cao việc trực quan hoá tài liệu dạy học.

2. Khả năng giải quyết trong một khối thống nhất các quá trình thông tin, giao lưu và điều khiển trong dạy học: Dưới góc độ điều khiển học thì quá trình dạy học là một quá trình điều khiển hoạt động nhận thức của học sinh. Với một chương trình phù hợp, máy tính có thể điiêù khiển được hoạt động nhận thức của học sinh trong việc cung cấp thông tin, thu nhận thông tin ngược, xử lí thông tin và đưa ra các giải pháp cần thiết giúp hoạt động nhận thức của học sinh đạt kết quả cao.

3. Tính lặp lại trong dạy học: Khác với giáo viên, máy tính có thể lưu trữ một thông tin nào đó, cung cấp và lặp lại nó cho học sinh đến mức đạt được mục đích sư phạm cần thiết. Trên cơ sở này, sự phát triển của từng cá thể học sinh trong quá trình dạy học trở thành hiện thực. Điều đó tạo điều kiện thuận lợi cho việc cá thể hoá trong quá trình dạy học.

4. Khả năng mô hình hoá các đối tượng: Đây chính là khả năng lớn nhất của máy tính. Nó có thể mô hình hoá cá đối tượng, xây dựng các phương án khác nhau, so sánh chúng và tạo ra phương án tối ưu. Thật vậy, có nhiều vấn đề, hiện tượng không thể truyền tải được bởi các mô hình thông thường, ví dụ các quá trình xảy ra trong lò phản ứng hạt nhân, hiện tượng diễn ra trong xi lanh của động cơ đốt trong, từ trường quay trong động cơ không đồng bộ ba pha, chuyển động của điện tử xung quanh hạt nhân …trong khi đó máy tính hoàn toàn có thể mô phỏng chúng.

5. Khả năng lưu trữ và khai thác thông tin: Với bộ nhớ ngaòi có dung lượng như hiện nay, máy tính có thể lưu trữ một lượng lớn dữ liệu. Điều này cho phép thành lập các ngân hàng dữ liệu. Các máy tính còn có thể kết nối với nhau tạo thành các mạng cục bộ hay kết nối với mạng thông tin toàn cầu Internet. Đó chính là những tiền đề giúp giáo viên và học sinh dễ dàng chia sẻ và khai thác thông tin cũng như xử lí chúng một cách có hiệu quả.

Thứ hai, ứng dụng CNTT trong dạy học có thể hỗ trợ cho nhiều hình thức dạy học khác nhau như: 
Dạy học giáp mặt (face to face); 
Dạy học từ xa (distance learning); 
Đào tạo trực tuyến (online training lab); 
Học dựa trên công nghệ web (web based training); 
Học điện tử (e – learning)… 
Các hình thức này đáp ứng được nhu cầu học tập ngày càng cao của các thành phần khác nhau trong xã hội.

Thứ ba, ứng dụng CNTT trong dạy học dẫn đến nhờ công cụ máy tính thực hiện một số chức năng của người thầy giáo ở những khâu khác nhau của một quá trình dạy học. Nhờ đó có thể xây dựng chương trình dạy học mà ở đó máy đã thay thế một số công việc của người giáo viên…
Cách dạy này đã thể hiện nhiều ưu điểm về mặt sư phạm như khuyến khích sự làm việc độc lập của học sinh, đảm bảo mối liên hệ ngược và cá biệt hoá quá trình học tập.

Bài 2. THIẾT KẾ BÀI GIẢNG BẰNG MICROSOFT POWERPOINT
1 Một số khái niệm cơ bản
MS Powerpoint: Là chương trình ứng dụng trong bộ phần mềm MS Office của hãng Microsoft. Dùng để thiết kế và trình chiếu thông tin. Đây là một phần mềm phổ biến được phát triển cho hệ điều hành Microsoft Windows và Mac. Được sử dụng rộng rãi trong giới doanh nhân, các nhà giáo dục đào tạo… và được coi là một dạng phổ biến nhất của công nghệ trình diễn. Theo nhà sản xuất, có khoảng 30 triệu trình diễn được tạo ra mỗi ngày.

Presentation (trình diễn): là sản phẩm được tạo ra từ MS Powerpoint. Trong mỗi Presentation cũng bao gồm các Slide như máy chiếu slide, chúng được sắp xếp theo một trình tự nhất định.

Sline chứa đựng các thông tin trình diễn. Bản thân trong mỗi slide có thể chứa nhiều thông tin khác nhau như chữ (text), hình ảnh (image), tranh vẽ (picture), âm thanh (sound), hoạt hình (animation), phim (movie),…

Trong quá trình trình diễn các thông tin, các slide có thể được xuất hiện một cách tự động hay tuân theo sự điều khiển của người dùng.

Với khả năng chứa đựng nhiều dạng thông tin trong một slide, với các hiệu ứng Animation kết hợp với sự sinh động khi chuyển đổi giữa các slide ( slide Transition), phần mềm này thực sự mạnh và rất hữu ích trong việc thay đổi phong cách giảng dạy của giáo viên nhằm nâng cao chất lượng dạy và học. Có thể nói, đối với quá trình dạy học, về mặt khả năng trình diễn thông tin, MS Powerpoint là tất cả những gì chúng ta cần. Đây là một sự thay thế tốt cho những gì chúng ta đã có trước đây.

Tuy nhiên không phải có MS Powerpoint là có tất cả. Như mọi phương tiện khác MS Powerpoint cũng chỉ là công cụ. Mọi nguồn thông tin ( hình ảnh, âm thanh, chữ viết,..) lấy ở đâu? Cách sắp xếp chúng theo trình tự thế nào? kịch bản ra sao? Lời thuyết minh cho thông tin ấy thế nào thì hoàn toàn phụ thuộc vào con người. Ở đây nảy sinh vấn đề làm thế nào để có được một Presentation với chất lượng cao? 
2. Qui trình thiết kế bài dạy bằng Powerpoint
Để có được một bài giảng tốt, việc thiết kế và xây dựng trình diễn phải được lập kế hoạch cụ thể và thực hiện theo từng bước nhất định. 

Dưới đây là một gợi ý:

Bước 1: Lựa chọn nội dung thông tin cần thiết thể hiện trong bài dạy
Bước 2: Chia nhỏ nội dung thông tin thành các modul. Mỗi modul thông tin được hiển thị trong một slide

Bước 3: Lựa chọn tối đa các đối tượng Multimedia có thể có dùng để minh hoạ cho nội dung học tập
Bước 4: Chuẩn bị tài nguyên (văn bản, hình ảnh tĩnh, động; mô hình mô phỏng; âm thanh; phim,..) bằng các công cụ phần mềm khác nhau
Bước 5: Sử dụng MS Powerpoint để tích hợp nội dung trên vào các slide.

Bước 6: Qui định cách thức hiển thị thông tin trong mỗi slide (Animation)
Bước 7: Qui định hình thức chuyển đổi giữa các slide
Bước 8: Viết các thông tin giải thích cho mỗi slide
Bước 9: In các nội dung liên quan tới bài giảng
Bước 10: Trình diễn thử và sửa đổi
3. Nâng cao chất lượng & hiệu quả khi thiết kế và sử dụng bài dạy bằng trình diễn Powrpoint
3.1. Yêu cầu chung

Thiết kế bài dạy bằng PP phải dựa trên lí luận dạy học, đặc biệt là lí luận dạy học hiện đại. Do vậy, PP chỉ là phần mềm có tính chất hỗ trợ cho giáo viên thực hiện ý tưởng sư phạm của mình một cách thuận lợi và hiệu quả hơn;

Cấu trúc bài dạy phải chặt chẽ, lôgic. Thông tin ngắn gọn, cô đọng, được bố trí trình bày một cách khoa học phù hợp với tiến trình lên lớp;

Thể hiện đồng bộ và hợp lí các đối tượng đa phương tiện để hỗ trợ cho các hoạt động nhận thức;

Bài dạy cần khuyến khích sự trao đổi giữa giáo viên và học sinh; tăng cường trao đổi, hợp tác giữa các học sinh; khích lệ tư duy, hoạt động độc lập, sáng tạo…;

Nội dung bài dạy phải cuốn hút, đảm bảo học sinh tập trung vào nội dung, lôgic của kiến thức;

Sử dụng bài dạy đúng kế hoạch, tiến trình với tư thế, cử chỉ, điệu bộ, giọng nói, ánh mắt của giáo viên hợp lí.

3.2. Nội dung cụ thể

3.2.1. Cấu trúc thể hiện bài dạy
Thực tiễn cho thấy, ý tưởng và con đường thể hiện ý tưởng là những yếu tố quan trọng, ảnh hưởng tới chất lượng bài giảng điện tử. 
Về cấu trúc thể hiện ý tưởng, có thể thực hiên theo một trong hai cách tiếp cận sau:

a) Yêu cầu:

Cấu trúc bài trình bày phải được thể hiện rõ ràng, lôgic;
Đảm bảo thể hiện rõ vị trí của nội dung đang trình bày trong toàn bộ cấu trúc của trình diễn.

b) Một số gợi ý:

+ Sử dụng cấu trúc đã được thiết kế sẵn:

PP cho phép thiết kế một  trình diễn mới theo một số thiết kế với những cấu trúc mẫu. Một vài trong số đó là Genneric (kiểu chung); Traning (đào tạo); Bussiness plan (kế hoạch kinh doanh); Brainstorming session (phương pháp công kích não)…

+ Sử dụng lưu đồ:

[image: image18.emf]   Cách tiếp cận này thường được sử dụng nhiều bởi tính đơn giản và logic của nó. Theo đó, bài trình bày được bắt đầu bằng cách công bố tóm tắt những nội (vấn đề ) chính cần trình bày, kế đến là lần lượt từng vấn đề được đề cập và giải quyết. 
Sau mỗi vấn đề thường có những tóm tắt và kết luận; 
Cuối cùng là các nội dung để kết thúc phiên trình bày.

+ Sử dụng cấu trúc hình sao:
Phần 1: Kích thích
Mục đích của phần này là đưa học sinh vào trạng thái bị kích thích, các em sẽ hưng phấn, tích cực, chủ động chuẩn bị cho việc lĩnh hội tri thức được thuận lợi và hiệu quả. 

Có nhiều kĩ thuật khác nhau để kích thích người học, dưới đây là một số biện pháp mang lại hiệu quả cao:

- Trình bày một câu chuyện ngắn hay một ví dụ gây tranh cãi;

- Sử dụng các câu hỏi khêu gợi, câu hỏi mở khiến học sinh hứng thú, tích cực tranh luận, đưa ra các phương án trả lời…

- Sử dụng một lời trích dẫn, nhận định liên quan tới nội dung bài học khiến học sinh rất quan tâm hay tháy bất ngờ;

- Khai thác những con số thống kê đáng chú ý về chủ đề bài dạy;

- Sử dụng cấc hiệu ứng đặc biệt như âm thanh, hình ảnh, hoạt hình, phim…
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Phần 2: Trình bày tổng quan
Phần này nhằm cung cấp cho học sinh một cách nhắn gọn nội dung học tập, các yêu cầu các em phải đạt được thông qua bài dạy (mục tiêu). 
Để làm tốt điều này giáo viên phải ý thức được rõ ràng bài dạy đề cập tới nội dung nào (nội dung), liên quan tới hệ thống kiến thức khác ra sao (tính kế thừa, sự tích hợp), nội dung được dạy cho ai (đối tượng), các em mong đợi gì ở bài dạy (mục tiêu)…

Phần 3: Thể hiện nội dung
Dựa trên cơ sở những thông tin đã được thiết kế trong bài dạy, giáo viên và học sinh lần lượt khám phá tri thức theo cách đã được xác định rõ ràng trong kế hoạch bài dạy. 
Chú ý sau mỗi phần, giáo viên thường đưa ra những nhận định cótính chất kết luận, tổng kết giúp học sinh nhận biết và khắc sâu từng phần trong tổng thể nội dung bài dạy, cũng nên dẫn dắt, kể các câu chuyện liên quan…khi chuyển từ nội dung này sang nội dung khác
Phần 4: Tóm tắt
Giai đoạn này sẽ giúp học sinh xem xét lại toàn bộ nội dung kiến thức đã được học. Trên cơ sở đó học sinh sẽ nhớ tốt hơn theo cách sắp xếp kiến thức theo một cấu trúc chặt chẽ, lôgic.

Phần 5: Kết luận và hoạt động
Những kết luận quan trọng của bài dạy, những hoạt động để vận dụng, hay kiểm tra sự hiểu biết của học sinh trên cơ sở những kết luận đó là những nội dung chính cần được thể hiện trong phần này. 

Cũng tại đây, giáo viên có thể đưa ra các hoạt động bước đầu đánh giá mức độ đạt được mục tiêu của bài dạy. 

+ Sử dụng biểu đồ dạng xương cá:
[image: image16.wmf]
Theo cách tiếp cận này, bài trình bày không trực tiếp đề cập tới thông điệp chính cần truyền đi mà nó được bắt đầu với những thông tin hỗ trợ, trên cơ sở đó, dẫn dắt, liên hệ và đi tới kết luận vấn đề chính cần đề cập.

+ Một số kĩ thuật đảm bảo thể hiện rõ vị trí nội dung trong cấu trúc:

  - Sử dụng các biểu tượng đồ hoạ

[image: image3]
Với cách này, người đọc dễ dàng nhận diện nội dung đang đề cập ở vị trí nào trong cấu trúc tổng thể về nội dung. 

Sẽ hiệu quả hơn khi các slide đó được kết nối với nhau thông qua hệ thống các liên kết được tạo ra bởi các biểu tượng đồ hoạ.


[image: image4]  

- Sử dụng các ghi chú khi một chủ đề thể hiện trên nhiều slide. 

Với cách này, người học dễ dàng theo dõi và nắm bắt được những chủ đề mà nội dung của nó được trình bày trong nhiều slide. Có thể biểu diễn bằng nhiều cách khác như đánh số thứ tự sau tiêu đề 1,2,3… hãy sử dụng thuật ngữ (tiếp) sau tiêu đề bắt đầu từ slide thứ 2 thể hiện chủ đề đó…

3.2.2. Nội dung thông tin:

Không thể và không nên đưa tất cả các thông tin cần trình bày với học sinh trên slide mà dựa trên cơ sở những thông tin trình chiếu, giáo viên và học sinh trao đổi, đàm thoại, hoạt động để hiểu sâu, hiểu rõ… vấn đề. Do vậy, trên một slide không trình bày quá nhiều ý, sử dụng các câu ngắn gọn, súc tích, đơn giản và dễ nhớ. 
Để cho nội dung trình diễn khoa học, có tính  logic và trực quan, việc chuyển tải nội dung dưới dạng sơ đồ cần được khai thác triệt để. Dưới đây là một gợi ý:

- Tăng cường sử dụng các biểu tượng đồ hoạ, các sơ đồ khối thay chữ viết;
- Mỗi slide chỉ nên thể hiện một ý;

- Sử dụng các cụm từ khoá hơn là một câu văn hoàn chỉnh;

- Chuyển đổi các câu thành các ý;

- Chỉ nên có 5 đến 6 dòng trên một slide;

- Mỗi dòng chỉ nên có không quá 6 từ.

- Sử dụng danh sách có thứ tự (danh sách có các kí hiệu như 1, 2, 3; a; b; c…) khi tầm quan trọng của các ý là khác nhau hoặc danh sách theo một trật tự nhất định.

- Sử dụng danh sách không có thứ tự (danh sách có các kí hiệu đồ hoạ trước mỗi ý) khi không có sự phân biệt về tầm quan trọng của các ý.

- Khuyến khích sử dụng các biểu tượng hình ảnh thay cho các dấu đầu câu trong danh sách.

3.2.3. Thể hiện nội dung bài dạy:
+ Độ lớn chữ viết: 

  - Đây là một yếu tố cần quan tâm nhằm đảm bảo cho tất cả người học có thể thu nhận thông tin một cách rõ ràng trên màn chiếu. Có thể tham khảo tiêu chuẩn dưới đây:

	Khoảng cách từ người quan sát đến màn chiếu (m)
	3
	6
	9
	12
	15
	18
	21
	24

	Chiều cao tối thiểu của chữ (mm)
	12
	25
	40
	50
	60
	75
	80
	100


Hình 6: Thông tin về cỡ chữ

Cần chú ý rằng, chiều cao của chữ trên màn chiếu phụ thuộc vào rất nhiều yếu tố như kiểu chữ, cỡ chữ, khoảng cách từ máy chiếu tới màn chiếu, khả năng phóng to, thu nhỏ của máy chiếu… Do vậy, tuỳ thuộc vào phòng học và trang thiết bị cụ thể mà chọn kiểu chữ và cỡ chữ để đáp ứng được tiêu chuẩn trên. Trong thực tế, nếu chọn cỡ chữ tối thiểu 20pt cho kiểu chữ .VnArial hay tương đương: tối thiểu 24pt cho kiểu chữ .Vntime hay tương đương.

Còn về kiểu chữ, nên sử dụng các kiểu chữ không chân vì đây là kiểu chữ dễ đọc. Nên lựa chọn và sử dụng không quá hai kiểu chữ nhằm đảm bảo tính cân bằng và nhất quán trong bài trình bày. Hạn chế sử dụng chữ in hoa vì nó sẽ làm mất hình dạng của kí tự gây khó đọc cho người quan sát. Ví dụ:

Nên dùng kiểu CHỮ KHÔNG CHÂN
KHÔNG nên dùng kiểu chữ có chân, hình dạng phức tạp

KHÔNG NÊN DÙNG NHIỀU NỘI DUNG BẰNG CHỮ IN HOA

+ Đảm bảo độ tương phản

Để nội dung thông tin trên màn chiếu rõ ràng, dễ đọc, cần đảm bảo nguyên tắc phối hợp giữa mẩu nền và mẫu chữ. Đó là, nếu màu nền là màu sáng thì màu chữ sẽ là màu tối và ngược lại. 
Có thể tham khảo một số cặp mẫu chữ - nền sau:

	Mầu nền
	Mầu vàng
	Mầu trắng
	Mầu xanh
	Mầu trắng
	Mầu đen

	Mầu chữ
	Mầu đen
	Mầu đỏ, xanh
	Mầu trắng
	Mầu đen
	Mầu vàng


                             Hình 7: Một số cặp mầu nền - chữ

Trong thực tế, có hai phong cách trình bày:

Màu nền tối, màu chữ sáng: Cách chọn này đảm bảo độ tương phản tốt, tuy nhiên, lớp học có thể bị tối, gây khó khăn cho học sinh ghi chép nội dung, kiến thức chính.

Mầu nền sáng, mầu chữ tối: Cách chọn này cũng đảm bảo độ tương phản tốt, lớp học sáng, học sinh có thể ghi chép tốt. Tuy nhiên, mầu nền sáng trong một thời gian dài có thể gây ức chế cho người học.

+ Xác định vùng hiển thị thông tin quan trọng: 
  - Một nghiên cứu chỉ ra rằng, khi mắt người nhìn vào một hình chữ nhật thì sự tập trung chú ý không giống nhau với các vùng khác nhau. Theo sơ đồ này, mắt người sẽ tập trung chú ý nhiều nhất vào phía trên, bên trái của khung hình chữ nhật. 
Đây chính là vùng mà người thiết kế nên đặt những đối tượng, thông tin quan trọng 


[image: image5]
Nếu muốn thể hiện một số sơ đồ thông qua sự xuất hiện lần lượt các khối thành phần, có thể tham khảo kết quả nghiên cứu về sự chuyển động của mắt khi quan sát một hình chữ nhật.
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+ Đảm bảo yếu tố ngắt dòng: 
Việc ngắt dòng không đúng sẽ làm cho người học rất khó đọc và ghi nhớ thông tin trình bày. 

Ví dụ dưới đây sẽ minh hoạ điều này:

	Ngắt dòng không đúng
	Ngắt dòng đúng

	PowerPoint là một phần

mềm ứng dụng cho

phép thiết kế và xây

dựng trình diễn
	PowerPoint là một phần mềm ứng dụng cho phép thiết kế và xây dựng trình diễn


Hình 10: Vấn đề ngắt dòng
+ Khai thác ý nghĩa các biểu tượng:
Lôgô, biểu tượng không những có thể cung cấp các thông tin về người trình bày, về tổ chức, về cá nhân,.. mà còn có tác dụng hỗ trợ quá trình nhận thức cho người học. Do vậy, trong bài trình bày, trên các slide nên sử dụng các biểu tượng phù hợp với nội dung đề cập. 

Ví dụ, có thể sử dụng một biểu tượng như dưới đây:
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+ Màu sắc và cấu trúc thông tin trong slide nhất quán
 Không nên sử dụng quá nhiều màu sắc trong một trình diễn (không quá 3 màu), điều này có thể khiến người học mệt mỏi. Cách bố trí các nội dung trong slide, màu nền, màu chữ nên trinh bày đồng bộ.

+ Hoạt hình các đối tượng trong slide:
Hoạt hình các đối tượng trong slide là cách thức làm cho từng thông tin hiển thị phù hợp với tiến trình dạy học của người thầy. PowerPoint cung cấp rất nhiều hoạt hình rất sinh động và hấp dẫn. Tuy nhiên, để định hướng người học tập trung vào nội dung trình bày, cần thiết sử dụng các hoạt hình đơn giản, chân phương.

+ Nhấn mạnh các thông tin trong slide:
Nhấn mạnh nội dung thông tin nào đó là một sức mạnh của PP và cũng là yêu cầu quan trọng khi thể hiện thông tin trong giờ dạy. Có nhiều cách thức để nhấn mạnh một nội dung nào đó như sử dụng chức năng hoạt hình (Animation). Với chức năng này, có thể tác động tới các đối tượng thông tin trong slide theo 4 cách khác nhau đó là: 
Entrance 

Xuất hiện; 
Emphasis 
Nhấn mạnh; 
Exit 

Biến mất;

Motion Paths 
Chuyển động tới một vị trí mới. 

Ngoài ra có thể nhấn mạnh một nội dung nào đó theo một số kĩ thuật sau:

- Nhấn mạnh theo vị trí, hình 12 (a)

- Nhấn mạnh theo màu sắc, 12 (b)

- Nhấn mạnh theo kích thước, 12 (c)

- Nhấn mạnh bởi yếu tố đồ hoạ, 12 (d)
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3.2.4. Sử dụng bài dạy bằng PowerPoint trong giờ học:

- Luyện tập cách trình bày:

Để đảm bảo thành công khi sử dụng trình diễn, cần thiết phải tập trình bày trước. Về mặt lí thuyết, số lần luyện tập trình bày là 4.

- Nhập đề thu hút sự chú ý: 

Yêu cầu này đúng trong mọi trường hợp dạy học. Với việc trình diễn bài giảng điện tử điều này càng cần thiết. Đây chính là biện pháp hạn chế sự căng thẳng, mệt mỏi,…khi người nghe tập trung quá nhiều trên màn chiếu.

- Tư thế đứng và chỉ dẫn thông tin:

Cần phải di chuyển, sử dụng que chỉ, đèn rọi một cách hợp lí. Với hình thức dạy học này, cần tránh đi lại quá nhiều trong lớp khi trình bày.

- Không đọc nguyên văn các thông tin trình chiếu: 
Bài dạy sẽ phản tác dụng nếu người trình bày chỉ đọc nguyên văn nội dung thông tin trình chiếu. Chú ý là những thông tin trình chiếu cho học sinh chỉ là những ý ngắn gọn, xúc tích, có tính gợi nhớ. Trên cơ sở những thông tin đó, giáo viên sẽ trao đổi, đàm thoại, có cơ hội tích cực hoá hoạt động nhận thức của học sinh và giúp các em hiểu rõ hơn về thông tin, nhận định… được trình chiếu.

- Giao tiếp bằng mắt:

Thường xuyên thể hiện sự nhiệt tình, quan tâm của mình thông qua ánh mắt. Điều này không những thu hút được sự tập trung chú ý của học sinh mà còn giúp giáo viên nhận biết được những thông tin phảnhồi về giờ dạy, bài học…

- Sử dụng giọng nói điệu bộ:

Đây là những yếu tố quan trọng tạo nên tính hấp dẫn, phong cách riêng của giáo viên. Giọng nói cần phải to, rõ và nên thể hiện theo kiểu trò chuyện, có nhấn mạnh, tránh nói đều đều hay theo kiểu diễn kịch, biến đổi ngữ điệu và tốc độ nói ngắt quãng để nhấn mạnh. Bên cạnh đó cần thiết phải thể hiện sự nhiệt huyết, say mê trong khi trình bày.

- Sử dụng các biện pháp gây phấn chấn đúng lúc:

Trạng thái tinh thần học sinh như hứng thú, tích cực nhận thức…sẽ đóng vai trò quan trọng tới chất lượng giờ dạy. Có nhiều yếu tố ảnh hưởng tới trạng thái tinh thần của các em như cấu trúc bài giảng, ánh mắt, giọng nói, điệu bộ…của giáo viên. Bên cạnh đó, có một vài biện pháp giáo viên có thể áp dụng để gây phấn trấn cho học sinh là kể các câu chuyện; nêu các con số thống kê, tạo sự so sánh, đặt câu hỏi, bắt chước, tạo sự chờ đợi hồi hộp và sử dụng các hiệu ứng đặc biệt như âm thanh, hoạt hình…

- Khai thác tối đa các phương pháp dạy học tích cực:

Ứng dụng CNTT trong dạy học sẽ không mang lại hiệu quả cao nếu trong khi dạy không khai  thác được các phương pháp dạy học tích cực. Cần quán triệt tư tưởng này ngay từ khi thiết kế bài dạy. Cụ thể hơn, trong trường hợp này, CNTT đóng vai trò là phương tiện hỗ trợ để thực hiện thuận lợi hơn các phương pháp dạy tích cực.

- Những điều nên tránh khi dạy học với PowerPoint

4. Làm quen với PowerPoint (PP)
4.1. Giao diện của PowerPoint


[image: image9]   Có nhiều phiên bản office khác nhau, phần mềm PP chúng tôi giới thiệu sau đây thuộc bộ office XP. Giống như nhiều ứng dụng khác chạy trên hệ điều hành windows, cửa sổ làm việc của PP có các thành phần cơ bản như hình sau

Trong đó, các thành phần cơ bản là:

- Thanh thực đơn ( Menu Bar )     

Với thanh thực đơn này, người dùng có thể thực hiện hầu hết các thao tác, chức năng của chương trình PP. Dưới đay là ý nghĩa cụ thể của một số thực đơn:
	Tên Menu
	Chức năng

	File
	Thực hiện các thao tác, chức năng liên quan tới tài liệu (file) do PP tạo ra như tạo mới (New), mở ( Open), lưu (Save, Save  as), xem trước khi in (Print Preview), in (Print) tài liệu..

	Edit
	Thực hiện các thao tác, chức năng cho việc soạn thảo nội dung tài liệu như di chuyển (Cut & Paste), sao chép (Copy & Paste), tìm kiếm (Find), thay thế (Replace) đối tượng..

	View
	Thực hiện các chức năng thay đổi giao diện của chương trình như hình thức hiển thị (Normal, Slide Sorter, Slide Show, Note page), ẩn hiện các thanh công cụ (Toolbar), thước (Ruler), lưới (Grid),…

	Insert
	Thêm Slide mới vào trình diễn hoặc chèn các đối tượng vào Slide như hộp văn bản ( Text box), hình ảnh ( Picture), âm thanh ( Sound), phim (Movie), biểu đồ (Chart), bảng biểu ( Table), các đối tượng nhúng ( Object)…

	Format
	Thực hiện các thao tác định dang Slide và các đối tượng như kiểu chữ (Font), căn lề (Alignment), mầu nền ( Background), mẫu thiết kế ( Slide Design), định dạng khung ( Slide Layout).

	Tools
	Thực hiện các tính năng nâng cao như kiểm tra ngữ pháp ( Spelling), tiện ích Macro, đặt cấu hình cho chương trình ( Options), tuỳ chỉnh ( Customize)…

	Slide Show
	Thực hiện các tính năng liên quan tới ttrình diễn như thiết lập các thông số trình diễn (Set up Show), hoạt hình các đối tượng kkhi trình diễn (Animation Schemes, Customize Animation), đặt chế độ chuyển đổi giữa các slide ( Slide transition)…

	Windows
	Quản lí, sắp xếp các tài liệu đang được mở

	Help
	Thực hiện các tính năng trợ giúp


- Thanh công cụ ( Toolbar):

PP cung cấp nhiều thanh công cụ ( có nhiều nút lệnh trên mỗi thanh), khi nhấp chuột vào đó sẽ thực hiện một chức năng tương ứng (hầu hết các chức năng thực hiện qua nút lệnh đều có thể thực hiện thông qua hệ thống Menu). Ví dụ, nhấp chuột vào nút lệnh có biểu tượng chiếc đĩa mềm trên thanh công cụ chuẩn Standard) sẽ lưu tài liệu hiện thời ( thao tác tương đương qua hệ thống Menu là: Fide => Save). Dưới đây là một vài thanh công cụ thường dùng:

- Thanh công cụ chuẩn (Standard bar): 

Dùng để thực hiện một số chưc năng chuẩn như tạo tài liệu mới, mở tài liệu đã có, lưu tài liệu, cắt dán các đối tượng, tạo bảng…

            [image: image10.emf]        
- Thanh công cụ định dạng ( Fomating bar): dùng để thực hiện các thao tác định dạng cho đối tượng trong tài liệu như chọn phông chữ, cỡ chữ, kiểu chữ, canh lề chữ…
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- Thanh công dụ vẽ (Drawing bar): dùng để vẽ và xử lí trực tiếp các đối tượng lên slide như vẽ đường thẳng, mũi tên, các hình cơ bản ( hình tròn, hình chữ nhật), các hình dựng sẵn (Auto Shapes), tạo chữ nghệ thuật…
- Thanh trạng thái (Status bar): là nơi cung cấp cho người dùng các thông tin trạng thái của tài liệu như số Slide, slide hiện thời, ngôn ngữ,…

- Thay đổi thực đơn và thanh công cụ: Có thể thêm, bớt, ẩn, hiện các chức năng ở thanh thực đơn và công cụ theo các cách sau:

              Chọn Tools => Cusomize

              Chọn View => Toolbars

              Nhắp chuột phải vào thực đơn hoặc một trong các thanh công cụ
4.2. Một số thao tác cơ bản với Presentation
4.2.1. Khởi động PP
 Sử dụng một trong các cách sau để khởi động chương trình PP:

              Start=> Programs=> microssoft PowerPoint

              Sử dụng Windows Explore mở file Powerpnt. Exe

              Mở trực tiếp từ các file trình diễn(*.ppt)
4.2.2. Tạo mới, mở một Presentation
  Khi PP mới khởi động hoặc chọn File=> New, cửa sổ Task pane hiện ra bên phải của cửa sổ chính. Có thể bắt đầu công việc với các lựa chọn dưới đây:

 Thực hiện lưu Presentation bằng một trong các cách sau:

             Chọn File=> Save

             Chọn nút lệnh save ( có hình đĩa mềm) trên thanh công cụ
             Với một file đã lưu, muốn sao sang một file có cùng nội dung với một tên khác thì chọn File=> Save As
4.2.3. Thoát khỏi PP

             Chọn File=> Exit

4.2.4. Thêm mới Slide
             Chọn Insert=> New slide: slide mới được thêm vào đồng thời cửa sôr Slide Layout hiện ra cho phép thay đổi layout của slide đó.

             Chọn Insert=> Duplicate slide: tạo ra một slide mới có nội dung, định dạng giống hệt với slide hiện tại ( sử dụng chức năng này kkhi slide mới cần thêm vào có nội dung hay định dạng gần giống với slide hiện thời)

4.2.5. Thay đổi vị trí của slide trong presentation
             Chọn tab Outline hay Slide tại cửa sổ bên trái (trong chế độ View=> Normal) hoặc chuyển về chế độ sắp xếp (View=> Slide Sorter), nhắp và giữ chuột trái vào slide cần thay đổi vị trí, xuất hiện đường kẻ mờ (thể hiện vị trí của slide), di chuột chuyển đường kẻ tới vị trí mới và nhả chuột.

4.2.6. Xoá Slide

             Xoá slide hiện tại: Chọn Edit=> Delete Slide.

             Xoá slide bất kì:    Chọn slide cần xoá trong tab Outline hay Slides hoặc trong chế độ sắp xếp và nhấn phím Delete trên bàn phím.

4.2.7. Chèn các đối tượng vào slide:

   Một trong những thế mạnh của PP là nó có thể chứa đựng nhièu dạng thông tin khác nhau như chữ viết (Text), hình ảnh (Picture), hoạt hình (Animation), âm thanh (Sound), phim (Movie), siêu liên kết (hyper link)…Dưới đây là cách chèn một số đối tượng vào trong slide của presentation:

- Chèn hộp văn bản: Chữ viết trong slide chỉ tồn tại dưới dạng hộp văn bản, trong một slide có thể chèn một hay nhiều hộp văn bản ở những vị trí khác nhau. Để chèn hộp văn bản vào slide chọn lệnh 

               Insert=> Text box
- Chèn ảnh: Thông thường, hình ảnh trong máy tính tồn tại dưới dạng tệp, thường phần mở rộng là *.bmp, *.gif, *.jpg, *.png…Vậy muốn chèn ảnh vào slide, trước hết phải tạo ra ảnh đó (bằng cách chụp hình, vẽ rồi scan, chụp hình bằng máy kỹ thuật số, sử dụng các phần mềm đồ hoạ vẽ trực tiếp trong máy tính…). Chọn lệnh:

              Insert=> picture=> From file…

- Chèn âm thanh, phim: Các thao tác chèn âm thanh và chèn phim được thực hiện tương tự nhưchèn ảnh. Chọn Insert=> Movies and Sounds=> Movies from file…(nếu muốn chèn phim) hoặc Sounds from file…(nếu muốn chèn âm thanh).

- Chèn đồ thị: Chọn Insert=>Chart, một vùng đồ thị được chèn vào slide kèm theo một bảng dữ liệu (Datasheet) tương ứng với đồ thị đó. Sửa chữa tiêu đề, nội dung trong bảng dữ liệu cho đồ thị cần chèn vào.

- Chèn siêu liên kết: Siêu liên kết (Hyperlink) là một đối tượng trong slide khi nhắp chuột vào đó sẽ chuyển tới một địa chỉ mới (slide khác trong presentation đó, slide trong một presentation khác…). Hyperlink thường dùng để chỉ ra nơi chứa các thông tin bổ xung, nội dung chi tiết cho các vấn đề đang trình chiếu. Ví dụ từ các tiêu đề học, chuyển tới các nội dung tương ứng trên các slide khác.
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4.3. Định dạng các đối tượng

  Với tất cả các đối tượng được chèn vào slide đều có thể định dạng lại cho đẹp và phù hợp với trình diễn như chọn font chữ, kiểu chữ, cỡ chữ (đối với text box), chọn màu nền, chọn đường bao, chọn kích cỡ, chọn chức năng liên kết…Để định dạng một đối tượng, thực hiện như sau:

                Chọn đối tượng cần định dạng.

                Chọn Format=> [tên đối tượng] (tên đối tượng đựoc hiển thị tương ứng với đối tượng chọn) hoặc kích chuột phải, chọn Format [Tên đối tượng] trong popup menu.

                Thực hiện thay đổi định dạng trong hộp hội thoại.

4.4. Hoạt hình các đối tượng trong slide

Các đối tượng trong slide có thể xuất hiện cùng một lúc, lần lượt, theo các hình thức biểu diễn sinh động. Để làm được điều này, ta sử dụng tính năng Animation (hoạt hình) các đối tượng. Các bước để hoạt hình một đối tượng như sau:

             Chọn đối tượng cần hoạt hình.

             Chọn Slide Show=> Animation Schemes (để chọn các hoạt hình thông dụng) hoặc Slide Show=> Custom Animation (để thực hiện các hoạt hình phong phú hơn)
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Chọn Schemes Animation hay thao tác với cửa sổ Custom Animation

4.5. Điều khiển khi trình diễn
	Mục đích
	Cách thức thực hiện

	Chuyển tới slide kế tiếp
	+ Nhấn chuột trái

+ Nhấn một trong các phím: Space bar, N, mũi tên phải, mũi tên xuống, Page Down, Enter.

	Quay lại slide trước
	Nhấn một trong các phím: Backspace, P, mũi tên trái, mũi tên lên, Page Up

	Đến một slide bất kì
	Gõ số thứ tự của slide đó rồi nhấn Enter

	Bật/Tắt chế độ bôi đen màn hình
	Nhấn phím B hoặc phím  “ . ”

	Bật/Tắt chế độ xoá trắng màn hình
	Nhấn phím W hoặc phím  “ ,”

	Hiện/Ẩn mũi tên ở góc trái màn hình
	Nhấn phím A hoặc phím  “ = ”

	Dừng/Tiếp tục trình diễn
	Nhấn phím S hoặc phím  “ + ”

	Xoá các nét vẽ trên màn hình
	Nhấn phím E

	Kích hoạt bút đánh dấu
	Nhấn phím Ctrl + P

	Ẩn con trỏ chuột và mũi tên
	Nhấn phím Ctrl + H

	Ẩn, hiện con trỏ chuột
	Nhấn phím Ctrl+U

	Kết thúc trình diễn
	Nhấn một trong các phím Esc, Ctrl+Break, -


Bài 3  SỬ DỤNG CÁC PHẦN MỀM ỨNG DỤNG ĐỂ THIẾT KẾ TÀI NGUYÊN BÀI DẠY

Để thiết kế tài nguyên bài giảng điện tử có hiệu quả trong dạy học, nhất thiết phải có được tài nguyên phong phú. Đó là tranh ảnh, hoạt hình, âm thanh, phim…Tài nguyên cho bài giảng có thể được tìm kiếm trên Internet, chia sẻ giữa các đồng nghiệp hay tự tạo, xử lí bằng các công cụ tin học. Dưới đây là một số phần mềm đồ hoạ có thể sử dụng để tạo tài nguyên bài giảng.

1. Nhóm các phần mềm đồ hoạ

Các phần mềm đồ hoạ là những phần mềm ứng dụng trong máy tính với mục đích trợ giúp vẽ, thiết kế, chỉnh sửa và lưu trữ dữ liệu đồ hoạ (dưới dạng số). Có thể khai thác một số phần mềm đồ họa dưới đây để xây dựng tài nguyên dạng ảnh cho bài dạng điện tử:

	STT
	Phần mềm
	Mô tả tóm tắt

	1
	AutoCAD


	Dùng để vẽ các bản vẽ kỹ thuật, cho phép thể hiện mô hình 3 chiều của vật thể, ưu điểm của phần mềm này là vẽ nhanh và chính xác.

	2
	Paint

(kèm hệ điều hành)
	Đây là phần mềm đi kèm với hệ điều hành windows. Cho phép vẽ những hình đơn giản, có độ chính xác vừa phải.

	3
	3D Studio Max


	Cho phép thiết kế những mô hình 3 chiều và xuất ra ảnh, phim…với nhiều định dạng khác nhau

	4
	Photoshop
	Là phần mềm xử lí và hiệu chỉnh ảnh rất hiệu quả


2. Nhóm các phần mềm thiết kế hoạt hình
Việc sử dụng các hoạt hình trong bài giảng sẽ làm tăng hiệu quả trình diễn thông tin, giúp học sinh hình dung rõ hơn đối tượng cần truyền tải. Có rất nhiều phần mềm khác nhau hỗ trợ thiết kế hoạt hình, một vài trong số đó là:

	TT
	Phần mềm
	Mô tả tóm tắt

	1
	Microsoft Gif Animator

(miễn phí)
	Phần mềm của hãng Microsoft cho phép thiết kế hoạt hình dưới dạng ảnh Gif động rất nhanh và đơn giản.

	2
	GIF Movie Gear

(phần mềm bản quyền)
	Có tính năng giống với Microsoft Gif Animator và thêm một số tính năng mới như khả năng biên tập các frame, tối ưu hoá hoạt hình…

	3
	Flash

(phần mềm bản quyền)
	Sản phẩm của Flash là một chuẩn đồ hoạ trên Internet. Phần mềm cho phép thiết kế những hoạt hình phức tạp, đẹp mắt, cho phép tương tác với người dùng một dung lượng khá nhỏ.


3. Khai thác tài nguyên bài giảng trên Internet
3.1. Tổng quan về Internet

+Mạng ( Network)
Là hai hay nhiều máy tính kết nối với nhau cho phép chúng có thể truyền thông (communicate) và chia sẻ (share) dữ liệu, mạng càng lớn thì khả năng truyền thông, chia sẻ dữ liệu càng lớn. Theo quy mô, có nhiều loại mạng khác nhau như LAN (local area network); MAN(metropolitan area network); WAN (wide area network).

+Internet
Là mạng máy tính lớn nhất thế giới, có thể coi Internet là mạng của mạng, phần lớn thông tin trên đó được trao đổi một cách tự do. Internet cũng có thể được coi là xa lộ thông tin (Superhighway)

+Khởi nguồn của Internet


- Năm 1969, Bộ quốc phòng Mỹ (DOD) xây dựng một mạng có tên là ARPANET, ý tưởng ban đầu của ARPANET là cho phép chia sẻ dữ liệu giữa các trung tâm nghiên cứu của chính phủ. ARPANET bắt đầu với 4 máy tính.

- ARPANET nhanh chóng trở nên có nhiều tính năng ưu việt tới mức nhiều trường đại học muốn kết nối vào nó. Đáp ứng nhu cầu đó, nó được tách ra làm hai là MILNET mạng này dành riêng cho quân sự và một mạng nhỏ hơn ARPANET được dùng cho mục đích phi quân sự.

- Vào năm 1972 có tới 40 mạng nhỏ kết nối với ARPANET, sau đó mọtt vài năm, năm 1980, một mạng khác có tên là CSNET ( Computer Science Researeh Network) kết nối với ARPANET. Thời điểm đó chính là thời điểm ra đời của Internet.

+ Các dịnh vụ cơ bản trên Internet:

- Electronic mail ( Email): Là một trong những dịch vụ phổ biến nhất trên Internet. Mọi người có thể gửi, nhận thư điện tử trong vài giây cho dù là người đó ở đâu. Liên quan tới dịch vụ gửi và nhận thư điện tử, có một số yếu tố sau:

· Địa chỉ Email: Muốn sử dụng dịch vụ Email, phải liên hệ với nhà cung cấp dịch vụ email (email service provider) – nơi có một máy tính đóng vai trò gửi, nhận thư điện tử (email server). Khi tạo một địa chỉ email, thực chất một tài khản (Account) được tạo ra trên email server, trong đó tên của Account chính là địa chỉ email. Cấu trúc chung của địa chỉ email có dạng:

Username@DomainName!

VD: Cknn1vp@vnn.vn (Cknn1vp là username; vnn.vn là Domainname)

· User name và Password: Được dùng để truy cập vào Account. Khi muốn nhận và gửi email thông qua account đã tạo trước đó, người truy cập phải cung cấp đủ thông tin về User name và Password.

· Email Client: Tại máy tính của người dùng, có những chương trình dùng để soạn thảo, nhận, gửi thư điện tử, những chương trình như thế được gọi là Mail Client. Một vài email client có thể kể tới như Eudora, Pine và Outlook Express.

- Telnet: Telnet là một chương trình cho phép người dùng truy nhập vào một máy tính khác trên Internet như là đang dùng ttrực tiếp máy tính đó. Với Telnet, người dùng có thể truy cập được vào các máy phục vụ, khai thác thông tin lưu trữ trong đó. Tuy nhiên, chỉ khi được phép của quản trị mạng (administrator) người dùng mới có thể truy nhập được máy phục vụ thông qua dịch vụ Telnet.

- FTP (File Transfer Protocol): Là một trong những phương pháp phổ biến dùng để truyền file thông qua Internet. Một máy tính lưu trữ thông tin có thể truy nhập được thông qua FTP được gọi là FTP Server. Muốn truy nhập được tài nguyên của FTP server, người dùng cần phải có user name và password.

- Archie: Sẽ có quá nhiều FTP server trên Internet, do vậy, việc tìm thông tin trên đó sẽ là một nhiệm vụ khó khăn. Để giải quyết nnhiệm vụ khó khăn này, người ta sử dụng dịch vụ tìm kiếm Archie. Tương tự như dịch vụ Email, dịch vụ Archie cũng có một Archie Server và một Archie Client.

- World Wide Web (WWW): WWW hay còn gọi là Web là một dịch vụ trên Internet cho phép truy cập hầu hết các loại tài liệu trên mạng Internet, trong đó bao gồm cả âm thanh, hình ảnh, phim. Nó hiển thị thông tin một cách nhanh chóng và dễ dàng. Trong dịch vụ WWW, thông tin hiển thị là trang web (web page). Một trang web có thể chứa: văn bản Text, hình ảnh, âm thanh, video, điều này dẫn tới thông tin trên mạng Internet thêm hấp dẫn và dễ xử lí. Để có thể sử dụng được dịch vụ WWW, hai thành phần sau là không thể thiếu được.

Web Server và địa chỉ: Trang web phải được khai thác tại bất cứ đâu trên mạng Internet và nó được đặt tại một máy tính đặc biệt gọi là Web server. Mỗi một web server có một địa chỉ duy nhất trên Internet. Định dạng chung của một địa chỉ Web như sau: 

www.nameofsite.countrycode. 

VD: www.google.com.vn
+ Browser (Trình duyệt):

  Là một phần mềm dùng để hiển thị các trang web. Có hai loại trình duyệt đó là Text based browser (là loại trình duyệt chỉ hiển thị thông tin dưới dạng văn bản chữ và Graphic based browser (là loại trình duyệt hỗ trợ hiển thị hình ảnh, âm thanh, phim…) Một vài trình duyệt nổi tiếng thế giới có thể kể tới là Netscape Navigator(của Nescape), Internet Explorer (của Microsoft).

3.2. Tìm kiếm thông tin trên Internet

+ Bộ máy tìm kiếm:

Một phần mềm tìm kiếm dữ liệu với những điểu kiện nhất định. Mỗi trang web tìm kiếm đều có sử dụng một bộ máy tìm kiếm được phát triển bởi chính nhóm tác giả tạo ra trang web hay mua lại bản quyền từ một đối tác khác. Bộ máy tìm kiếm có thể rất khác nhau về cơ chế tìm kiếm và chỉ mục các tài nguyên trên web và cách thức tìm kiếm từ yêu cầu của người dùng.

Sử dụng các công cụ tìm kiếm, giáo viên có thể khai thác kho tàng khổng lồ về các thông tin trên Internet dưới nhiều định dạng khác nhau như chữ viết, hình ảnh, hoạt hình, phim, âm thanh…

+ Một số website tìm kiếm:

   http:// www.Ask.com: Trang web tìm kiếm thông tin qua những yêu cầu của người dùng dưới dạng “ngôn ngữ tự nhiên”.

  http:// www.google.com.vn: Là một trong những công cụ tìm kiếm thông tin lớn nhất trên web. Tiêu chí của họ là tổ chức một thế giới thông tin và biến nó thành đối tượng hữu ích và có thể truy xuất mọi lúc mọi nơi. Có thể tìm kiếm nhiều tài nguyên khác nhau nhwweb, ảnh, nhóm, tin tức…

  http:// www.altavista.com: đây là công cụ tìm kiếm đầu tiên sử dụng chỉ mục cho từng từ trong trang web và cung cấp một hệ thống tìm kiếm để trích dẫn các thông tin có liên quan.

  http:// www.gigablast.com: Sử dụng công nghệ phỏng đoán trong yêu cầu tìm kiếm, ví dụ, nêu câu hỏi “Who is the presedent of th USA?”, bộ máy tìm kiếm sẽ tự động phân tích và đưa ra câu trả lời “is Presedent Bush”

 Ngoài ra có rất nhiều trang web tìm kiếm khác, có thể tham khảo thêm:

  http:// www.alltheweb.com
  http://search.ch
  http:// www.snap.com
  http:// www.objectssearch.com
  http:// www.vinaseek.com
Phần 2: 
MỘT SỐ BÀI THỰC HÀNH
Bài 1: HỆ ĐIỀU HÀNH, CÁCH THỨC KHAI THÁC CÁC TÀI NGUYÊN TRONG MÁY TÍNH

I. Mục tiêu
   Học xong bài này, học viên cần phải đạt được các mục tiêu sau:

  - Hiểu được phương pháp quản lí, tạo mới và lưu trữ dữ liệu trong máy tính.

  - Biết được một số chức năng cơ bản hệ điểu hành cung cấp cho người dùng, cách thức khai thác tài nguyên trong máy tính.

  - Nhận biết được cấu hình của máy tính và những thao tác sửa chữa đơn giản.

II. Chuẩn bị

  Học viên: Nghiên cứu phần lí thuyết về hệ điều hành. Chú ý tới các thao tác cơ bản với hệ điều hành.

  Cơ sở vật chất: Máy tính và các thiết bị ngoại vi (máy in, máy quét…)

III. Nội dung và quy trình thực hành
  Mỗi học viên sẽ làm thực hành trên một máy tính riêng. Nội dung và tiến trình thực hành cụ thể như sau:

  1. Thực hiện thao tác mở và tắt máy đúng quy định.

  2. Tìm hiểu và thực thi các chức năng trong Start Menu.

  3. Chạy một chương trình bằng một số khác nhau (qua cửa sổ Run, qua Start Menu, qua Shortcut…)

  4. Xây dựng một cây thư mục riêng để lưu trữ thông tin.

  5. Tìm kiếm thông tin trong máy tính thông qua chức năng Search.

  6. Điều chỉnh các thông số liên quan tới hệ điều hành, các thiết bị ngoại vi trong Control Panel.

  7. Cài đặt các phần mềm ứng dụng
  8. Cài đặt và xác định cấu hình cho máy in.

  9. Thực hiện một số thao tác sửa chữa đơn giản bằng các công cụ trong System Tools.

IV. Đánh giá
 Để đánh giá kết quả bài thực hành, yêu cầu hoàn thành các câu hỏi sau:

  1. Máy tính quản lí và lưu trữ dữ liệu như thế nào?

  2. Liệt kê các phần mềm đã cài vào trong máy tính?

  3. Trình bày các thao tác để cài đặt máy in?

  4. Làm thế nào để gỡ bỏ một chương trình đã cài đặt trong máy tính?

  5. Xem thông tin liên quan tới cấu hình của máy tính, các thiết bị ngoại vi bằng cách nào?

  6. Xem một hình ảnh trong máy tính ở hai chế độ 16 mầu và 16 bit mầu; chế độ nào ảnh có chất lượng cao hơn? Làm thế nào để thay đổi số mầu hiển thị trên màn hình?

  7. Các bước chung nhất để cài đặt một phần mềm là gì?

Bài 2: THIẾT KẾ VÀ XÂY DỰNG BÀI GIẢNG ĐIỆN TỬ BẰNG PHẦN MỀM POWERPOINT

 I. Mục tiêu
  - Biết được các đối tượng cơ bản trong PowerPoint.

  - Biết được các thao tác liên quan tới việc tạo một trình diễn.

  - Biết được một số phương pháp xây dựng tài nguyên cho trình diễn.

  - Thiết kế và xây dựng được bài giảng điện tử.

  - Sử dụng được bài giảng trên trong dạy học.

II. Chuẩn bị 
  Học viên: Nghiên cứu kỹ nội dung lí thuyết về phần mềm PowerPoint . Chuẩn bị trước nội dung cho trình diễn. Tạo sẵn các tài liệu ảnh, âm thanh, phim có liên quan tới trình diễn (nếu có).

  Cơ sở vật chất: Máy tính có cài đặt bộ phần mềm văn phòng Microsoft Office, các phần mềm đồ hoạ.

III. Nội dung và quy trình thực hành
   Giống như bài thực hành 1, mỗi học viên sẽ thực hành trên một máy tính. Bài thực hành này được thực hiện trong 2 buổi, nội dung và tiến trình cụ thể của từng buổi như sau:

Buổi 1: 

  1. Tạo mới và lưu một trình diễn.

  2. Chèn các đối tượng vào trong một Slide ( màu nền-Background; biểu đồ-Chart; các đối tượng nhúng-Object; liên kết-Link; thao tác vẽ trực tiếp vào Slide-Drawing…). Sử dụng Slide Master.

  3. Thiết kế trình diến trong các chế độ nhìn-View khác nhau.

  4. Thực hiện các thao tác đối với Slide (chọn màu, thêm, xoá, thay đổi vị trí của các Slide trong trình diễn)

  5. Hoạt hình các đối tượng trong Slide-Animation

  6. Thực hiện trình diễn.

  Buổi 2: 
  1. Thêm các thông tin phụ trong Slide (Header, Footer)

  2. Thiết lập chế độ trình diễn (Slide Show).

  3. Thiết kế và xây dựng một trình diễn trọn vẹn (bài giảng điện tử) có nội dung đã được chuẩn bị trước.

  4. Xây dựng phương án giảng dạy với trình diễn trên.

  5. In các thông tin của trình diễn trên.

IV. Đánh giá
  Các câu hỏi đánh giá kết quả thực hành:

  1. Trình bày những ưu điểm của việc thiết kế bài giảng bằng PP?

  2. Vai trò của Slide Master là gì?

  3. Muốn xây dựng một trình diễn tự động chuyển Slide sau một khoảng thời gian nhất định và lặp đi lặp lại cần thực hiện những thao tác nào?

  4. Liên kết trong trình diễn dùng để làm gì? Có những thông tin nào một liên kết có thể trỏ tới?

  5. Chức năng nào dùng để hoạt hình các đối tượng trong Slide?

  6. Kể tên các chế đọ View và chức năng của nó?

  7. Khi xây dựng và sử dụng các bài giảng bằng PP, cần có những chú ý gì?
Bài 3 KẾT NỐI VÀ KHAI THÁC THÔNG TIN TRÊN INTERNET

I. Mục tiêu
- Kết nối được với internet thông qua Modem hoặc mạng LAN

- Tìm kiếm và khai thác thông tin trên mạng internet một cách hiệu quả.

II. Chuẩn bị

Học viên nghiên cứu các tài liệu có liên quan tới việc kết nối và làm việc trên internet, dự kiến nội dung cần tìm kiếm.

Cơ sở vật chất: Máy tính, modem, đường điện thoại, mạng LAN có kết nối internet.

III. Nội dung và quy trình thực hành
1. Thiết lập các tham số để kết nối với internet thông qua modem và đường dây điện thoại.

2. Kết nối với internet thông qua LAN

3. Khai thác các dịch vụ khác nhau trên in ternet (Email, WWW, FPT…)

4. Tìm kiếm thông tin trên internet.

IV. Đánh giá
Các câu hỏi đánh giá thực hành:

1. Trình bày các thao tác để kết nối với internet thông qua modem.

2. Kể tên một vài trang Web dùng để tìm kiếm thông tin trên mạng internet.

3. Nêu các chức năng cơ bản của một chương trình Mail Client.

4. Khi một thư điện tử được gửi, hành trình của nó đi như thế nào? Khi người nhận chưa kết nối internet hoặc tắt máy, thư điện tử được cất giữ ở đâu?
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